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Наставна програма: 

• Основите на Хардверот (лекција 1);  

• Основите на оперативниот систем Виндоус ХП(Windows XP) (лекција 2 и 

3):  

• Инсталација и подесување;  

• Опции на дисплејот;  

• Виндоус експлорер (Windows explorer);  

• Микрософт ворд 2000 (MS Word 2000) (лекции 4 , 5 , 6 , 7):  

• Инсталација и подесување;  

• Користење на различни фонтови (Македонски);  

• Ворд 2000 (Word 2000) Опции на менито (File, Edit, Format, Tools, 

Window, Help);  

• Инсертирање на објекти, симболи и слики;  

• Работа со табели во Ворд 2000 (MS Word 2000);  

• Користње на менито за цртање;  

• Интернет (лекции 8 , 9 и 10):  

• Запознавање со Интернет;  

• Пребарување низ Интернет и барање на одредена информација;  

• Отварање на бесплатна емаил адреса (на www.yahoo.com) и 

запознавање со емаил комуникацијата;  

• Директна Интернет комуникација користејки го yahoo chat; 





Lekcija 1 

Osnovite na Hardverot 
Sekoj kompjuter se sostoi od dva dela i toa: 

• Ma{inski del - hardver, koj go so~inuvaat site fizi~ki 
delovi. 

• Programski del - softver, koj go so~inuvaat site programi koj 
kompjuterot gi izvr{uva. 

 
Ma{inskiot del (hardverot) kaj kompjuterite se deli na slednite 

grupi: 
1. Centralna edinica; 
2. Nadvore{ni memorii; 
3. Vlezni edinici; 
4. Izlezni edinici; 
5. Ostanati elementi; 

 
Centralna edinica 

Glavnite delovi na sekoj kompjuter se smesteni vo Centralnata 
edinica koja e smestena vo metalno ku}i{te. Postojat razli~ni vidovi 
na ku}i{ta no voglavno se delat na dve grupi horizontalni i 
vertikalni. Glavnite delovi na centralnata edinica se nao|aat na 
edna plo~a nare~ena Mati~na plo~a. Mati~nata plo~a  se sostoi od 
razni elektronski kola i specijalni le`i{ta nare~eni slotovi na koi 
se montiraat procesorot, vnatre{nite memorii i karti~ki so razni 
adapteri i kontroleri. Preku t.n. porti na karti~kite se priklu~uvaat 
vleznite i/ili izleznite edinici. Vo ku}i{teto se nao|aat i edinicite 
za nadvore{na memorija, kako i transformatorot koj  go transformira 
visokiot napon na elektri~nata mre`a vo nizok. 

 
Procesor 

 Procesorot ja ima glavnata zada~a vo kompjuterot - da vr{i 
obrabotka na podatocite. Toj se sostoi od golem broj na elektronski 
kola povrzani vo funkcionalna celina i spakuvani vo eden ~ip. 

 Elektronskite kola na procesorot pominuvaat od edna 
sostojba vo druga, spored impulsite {to doa|aat od t.n. takt-generator 
koj raboti na odredena frekvencija (broj na promeni na nekoja veli~ina 
vo edinica vreme, 1MHz=1.000.000 promeni vo sekunda). Ovie impulsi ja 
odreduvaat rabotnata frekvencija na porcesorot. Kaj postarite 
procesori rabotnata fre7kvencija e bila od 4,7 do 50 MHz, taa 
postepeno se zgolemuvala taka da dene{nite procesori imaat rabotna 
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frekvencija od 1,2GHz pa do 3,4GHz (1GHz=1000MHz). Najpoznati 
svetski proizvoditeli na procesori se: Intel, AMD, Motorola, IBM, DEC, 
Cyrix i drugi. 

 
Vnatre{na memorija 

 Sekoj kompjuter ima dva vida na vnatre{na memorija i toa 
vnatre{na memorija koja mo`e samo da se ~ita (ROM) i vnatre{na 
memorija koja mo`e da se ~ita no i vo koja mo`e da se zapi{uva (RAM). 
Va`na osobina na ROM memorijata e {to nejzinata sodr`ina ne se gubi 
so isklu~uvawe na kompjuterot od elektri~nata mre`a. Vo ROM 
memorijata se smesteni programi koi go doveduvaat kompjuterot vo 
rabotna sostojba, tie programi go so~inuvaat t.n. BIOS. Kapacitetot na 
ROM memorijata zavisi od proizveduva~ot no naj~esto ima kapacitet od 
256KB ili poretko 512KB. Vo RAM memorijata podatocite slobodno 
mo`at da se zapi{uvaat, bri{at i premestuvaat od edno mesto na drugo. 
So prekinuvawe na elektri~nata energija vo kompjuterot, site podatoci 
se gubat, zatoa za trajno za~uvuvawe na podatocite se koristi 
nadvore{nata memorija. Kapacitetot na RAM memorijata vo postarite 
modeli na kopmjuteri e bila od 4MB do 32MB no vo dene{nite ta se 
dvi`i od 128MB pa do nekolku GB. 

 
Nadvore{ni memorii 

 Za trajno za~uvuvawe na podatocite se koristat nadvore{ni 
memorii. Podatocite i programite na nadvore{nite memorii se 
zapi{uvaat vo logi~ki celini nare~eni datoteki, sekoja datoteka ima 
edinstveno ime, a logi~kata organizacija na datotekite zavisi od 
operativniot sistem. Naj ~esto koristena nadvore{na memorija e 
magnetniot disk (Hard Disk), koj se vgraduva vo centralnata edinica. 
Kaj postarite modeli na diskovi kapacitetot e bil mnogu mal okolu 
54MB no kaj ponovite kapacitetot se dvi`i od 20GB pa i do 300GB. 
Pokraj magnetniot disk imame i magnetna disketa (Flopi disk) so 
standarden kapacitet od 1,44MB, Kompakt disk (CD) so kapacitet od 
650MB do 800MB, Opti~ki disk, Digitalen video disk (DVD), magnetna 
lenta. 

 
 
Vlezni edinici 

 Za da mo`e ~ovekot da komunicira so kompjuterot potrebni se 
posebni uredi t.n. vlezni edinici. Preku vleznite edinici mu se 
zadavaat site komandi na kompjuterot. Zada~ata na vleznite edinici e 
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primenite komandi da gi pretvori vo elektri~ni impulsi razbirlivi za 
centralnata edinica. Vlezni edinici ima mnogu no ja~esto koristeni se: 

 
1. Tastatura; 2. Gluv~e; 
3. Trekbol; 4. Palka (Xojstik); 
5. Svetlosno pero; 6. Skener; 
7. Digitalna kamera; 8. Mikrofon; 
9. Skener i dr.  

 
Izlezni edinici 

 Izleznite edinici imaat sprotivna zada~a od vleznite 
edinici t.e. tie gi primaat obrabotenite rezultati vo oblika na 
elektri~en signal i gi konvertiraat i prezentriaat na na~in {to e 
razbirliv za ~ovekot: broevi, tekst, slika, zvuk. Naj~esto koristeni 
izlezni edinici se: 

1. Monitor; 
2. Pe~ata~; 
3. Zvu~nik i dr. 

 
Vlezno izlezni edinici 

 Uredite preku koi se vnesuvaat i iznesuvaat podatoci od 
kompjuterot se vikaat vlezno-izlezni edinici. Eden od niv e modemot.
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Lekcija 2 i 3 

Osnovite na operativniot sistem Windows 

Neophodna programa bez koja ne mo`e da raboti kompjuterot e 
operativniot sistem. Dominanten operativen sistem za dene{nite 
personalni kompjuteri e Windows. Windows e operativen sistem na 
amerikanskiot proizveduva~ Microsoft namenet za personalni 
kompjuteri. 

Postojat nekolku varijanti na Windows i toa: Windows 95, Windows 
98, Windows NT, Windows 2000, Windows ME, Windows XP, Windows 2003. 

Windows operativniot sistem e grafi~ki orientiran t.e. raboti so 
filozofijata na simulacija na rabotna masa (Desktop). Windows ekranot 
gi sodr`i slednite delovi: 

• Ikoni (Icons) - ikonite se sliki koi prezentiraat programi, 
fajlovi, uredi za memorija i dr. 

•  Rabotna povr{ina (Desktop) - Desktop e osnovna rabotna 
povr{ina na koja se odvivaat site aktivnosti na 
aplikaciite. Taa e objekt so svoi svojstva koi mo`e da se 
prilagoduvaat na soodvetnite potrebi. Taa mo`e da dr`i 
razli~ni drugi objekti vo forma na nivnite grafi~ki 
simboli, ikoni ili otvoreni prozorci. 

• Poka`uva~ na gluv~eto (Mouse pointer) - ova strelka se 
koristi za da se poso~at naredbite. Taa se pomestuva so 
pomestuvawe na gluv~eto. 

• Moj kompjuter (My computer) - ikonata My computer dava 
pristap na prozorec vo koj mo`e da se vidi {to sodr`i 
kompjuterot ili da se dobie nekoja informacija za uredite na 
nadvore{nite memorii. 

• Ko{nica za otpadoci (Recycle bin) - Slu`i kako elektronska 
ko{nica za otpadoci. Vo nea se stavaat site nepotrebni 
fajlovi, folderi i ikoni, koi podocna mo`e da se povratat. 

• Kop~e Start - Menito Start sodr`i naredbi za aktivirawe na 
programi, menuvawe na konfiguracionite parametri na 
sistemot, pronao|awe na fajlovi i folderi, povikuvawe na 
sistemot za pomo{, isklu~uvawe na kompjuterot i t.n. 

• Lenta so zada~i (Taskbar) - ovaa lenta se protega na dolniot 
del na ekranot (mo`e i da se pomestuva), postojano e vidliva 
i na nea se pojavuvaat soodvetni kop~iwa za sekoja 
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aktivirana aplikacija. Koga istovremeno se koristat pove}e 
aplikacii, }e se vidat kop~iwa na site aplikacii. 

• ^asovnik (Clock) - se nao|a na desniot kraj od lentata so 
zada~i i go poka`uva momentalnoto vreme. 

 
Skoro site akcii vo Windows mo`at da se izvedat i so gluv~eto i 

so tastaturata. Elementarni akcii so gluv~eto se: 
• Dvi`ewe na prika`uva~ot - na ekranot poka`uva~ot na 

gluv~eto e prika`an vo forma na strelka koja se dvi`i so 
dvi`ewe na glu~eto po povr{inata na masata vo ~etiri 
osnovni pravci: napred - nazad (na ekranot se preveduva so 
gore-dole) i levo-desno, kako i kombinacija na ovie pravci. 

• Izbor na objekt (Klik) - ovaa akcija se izveduva so kratko 
pretiskawe i otpu{tawe na levoto kop~e na gluv~eto. 
Akcijata deluva isklu~ivo na objektot nad koj se nao|a 
poka`uva~ot. 

• Aktivirawe na objekt (Dvoklik) - se izveduva na toj na~in {to 
levoto kop~e na gluv~eto se pretiska dvapati edno podrugo 
so mnogu mala pauza pome|u niv. 

• Alternativna akcija (Klik so desno kop~e) - se izveduva isto 
kako so izbirawe na objektot, no se pretiska desnoto kop~e 
na gluv~eto, so {to obi~no se ispi{uva pomo{na lista na 
naredbi za objektot nad koj se nao|a poka`uva~ot. 

• Pomestuvawe na objektot - poka`uva~ot se doveduva na 
objektot, se dr`i pretisnata levoto kop~e i pritoa se 
pomestuva gluv~eto. Poka`uva~ot so sebe go nosi izbraniot 
objekt, se dodeka kop~eto ne se pu{ti. 

 
Sekoja startuvana aplikacija na ekranot se manifestira kako 

prozorec. Prozorec e pravoagolen del na ekranot vo koj se gledaat 
programi, folderi, fajlovi i ikoni. Prozorecot go so~inuvaat nekolku 
elementi koi se isti za site prozorci vo Windows-ot: 

• Naslovna lenta (Title bar) - vo ovaa lenta se prika`uva imeto 
na prozorecot. 

• Kop~e za minimizirawe - so kliknuvawe na ova kop~e, 
prozorot se namaluva vo forma na kop~e na lentata so 
zada~i. So kliknuvawe na kop~eto od lentata so zada~i 
prozorecot povtorno se prika`uva na ekranot. 

• Kop~e za vra}awe - so kliknuvawe na ova kop~e prozorecot se 
zgolemuva na celiot ekran ili se namaluva na del od 
ekranot. 
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• Kop~e za zatvarawe - na ova kop~e se kliknuva za da se 
zatvori prozorecot. 

• Meni lenta - Na ova lenta se prika`ani imiwata na menijata 
preku koi se pristapuva do naredbite. 

• Lenta so alatki - kop~iwata na lentite so alatki 
ovozmo`uvaat pobrzo odbirawe na naredbite. 

• Raboten prostor - vo ovoj prostor se prika`uva sodr`inata 
na prozorecot. 

• Lenti so lizga~i - so kliknuvawe na lizga~ite se ovozmo`uva 
dvi`eweto niz sodr`inata na prozorecot ako taa e pogolema 
od prozorecot. 

• Statusna lenta - vo koja se prika`ani dopolnitelni 
informacii za sodr`inata na prozorecot. 

 
Windows Explorer 
Osnovna sistemska aplikacija vo Windows koja se koristi za 

organizirawe na podatocite na kompjuterot, kopirawe i premestuvawe 
na fajlovite i folderite, formatirawe na disketi i dr. se vika 
Windows Explorer. Windows Explorer se aktivira na sledniov na~in: 

1. Se otvara menito Start i se izbira Programs; 
2. Vo menito Programs se pronao|a Windows Explorer; 
3. Se izbira Windows Explorer. 

 
Rabotnata povr{ina na Windows Explorer se sostoi od dva dela. 

Leviot del ima naziv All folders i gi prika`uva site memoriski uredi i 
folderi koi se nao|aat na kompjuterot. Vo desniot del se sodr`i 
listata na folderi i fajlovi koi gi sodr`i izbraniot folder od 
levata strana. 

Zaradi pogolema preglednost i organiziranost site dokumenti 
(fajlovi) se smestuvaat vo papki (folderi). Eden folder mo`e da 
sodr`i pove}e podfolderi (podpapki) vo koi mo`e da ima i drugi 
folderi i fajlovi. 

Nekoi fajlovi i folderi se kreiraat avtomatski so instalacija 
na aplikaciite, na primer so samata instalacija na operativniot 
sistem se kreiraat nekolku sistemski folderi (Windows, Program files, 
My documents....) koi ne smeat da se diraat. 

Sekoj korisnik mo`e da kreira svoi folderi, naj~esto toa se 
folderi vo koi se ~uvaat li~ni dokumenti. Prepora~livo e da se 
kreiraat posebni folderi za dokumenti so srodni sodr`ini. Fajlovite 
se kreiraat so soodvetna aplikacija (Word, Excel, Corel....). 
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Za kreirawe na nov folder, koristej}i go Windows Explorer, se 
izvr{uvaat slednive ~ekori: 

1. Vo leviot del na prozorecot se ozna~uva mestoto (diskot, 
folderot) vo koe sakame da kreirame folder. 

2. Se selektira naredata File->New->Folder, po {to vo desniot 
del na prozorecot se pojavuva ikona so ime New Folder. 

3. Se vpi{uva imeto na noviot folder i se pretiska Enter. 
 
^esto pati se javuva potreba nekoj fajl ili folder da go imame na 

dve mesta, ili da go premestime od edno mesto na drugo, zatoa gi 
koristime komandite Copy i Cut. 

Komandata Copy pravi kopija od izbraniot folder ili fajl, a 
komandata Cut gi premestuva istite, i se korista na sledniov na~in: 

1. Se izbira folderot {to gi sodr`i fajlovite ili folderite 
{to treba da se kopiraat/premestat 

2. Se selektiraat potrebnite fajlovi i/ili folderi 
3. Se selektira naredbata Edit->Copy ako se kopira, odnosno 

naredbata Edit->Cut ako se premestuva. 
4. Se izbira folderot vo koj treba da se kopiraat/premestat 

fajlovite i/ili folderite 
5. Se selektira naredbata Edit->Paste 

 
Isto taka mnogu ~esto se javuva potreba da se promeni imeto na 

odreden fajl ili folder. Toa se pravi na slednov na~in: 
1. Se selektira fajlot/folderot na koj treba da mu se promeni 

imeto 
2. Se selektira naredbata File->Rename. Po {to se pojavuva 

kvadrat~e okolu imeto na fajlot ili folderot pri {to 
iemto e selektirano 

3. Se vpi{uva novoto ime koe go zamenuva staroto i se pretiska 
Enter. 

 
Ponekoga{ e potrebno nekoj fajl/folder da se izbri{e i se pravi 

na sledniov na~in: 
1. Se izbira fajlot/folderot {to treba da se bri{e 
2. Se selektira naredbata Fajl->Delete po {to se pojavuva 

dijalog prozorec koj né pra{uva dali sme sigurni za 
zadadenata komanda.  

3. Otkako pretpazlivo }e pogledneme dali toa e sigurno 
fajlot/folderot koj sakame da go bri{eme ja izbirame 
soodvetnata komanda (Yes za potvrdno, ili No ako sme se 
preodmislile
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Lekcija 4, 5, 6 i 7 

 

 Tekstualen Ureduva~ MS Word 2000 

Personalniot smeta~ kako sofisticirana ma{ina, blagodarej}i 
na svoite mo`nosti sekojdnevno se upotrebuva vo mnogu oblasti. Kako 
edna  od najzastapenite oblasti vo koja smeta~ot e nezemenliv e  
ureduvaweto na tekst. Za taa cel se napraveni golem broj aplikativni 
programi koi se nare~eni ureduva~i na tekst ili tekst procesori. 

Denovive eden od najrasprotranetite i naj zastapeni tekstuali 
ureduva~i e tekst procesorot Microsoft Word 2000, proizvod na firmata 
Microsoft. Microsoft Word 2000 raboti na Windows platforma. 

Ednostavnosta za rabota i ogromnite mo`nosti kako {to se: 
kompatibilnosta so drugite tekstualni ureduva~i, mo`nosta za 
koristewe na golem broj na azbuki, prisustvoto na ednostaven no 
efikasen ureduva~ na matemati~ki formuli, postoeweto na golem broj 
simboli, mo`nosta za ureduvawe tabeli, mo`nosta za vmetnuvawe na 
bezbroj drugi elementi kako {to se sliki, tabeli, grafici i drugo go 
pravat Microsoft Word 2000 eden od naj zastapenite i naj koristenite 
tekstualni ureduva~i na zemjinata planeta. 

Bidej}i Microsoft Word 2000 kako tekstualen ureduva~ e namenet 
pred se za ureduvawe na tekst vo nego se vgradeni golem broj na funkcii 
koi ja olesnuvaat i pomagaat rabotata so tekstovi. Takvite funkcii 
kako {to se: postavuvaweto na margini na stranicite, postavuvawe na 
proizvolen prored, menuvawe na azbukata (kirilica, latinica, kineska 
i dr), zamena na stilot na tekstot, prebaruvawe na zborovi ili 
re~enici i zamena na istite so drugi, zamena na stilot na fusnotite, 
deleweto na zborovite na slogovi, numerirawe na stranicite i u{te 
mnogu drugi, samo ja zgolemuvaat popularnosta na ovoj tekstualen 
ureduva~ i pridonesuvaat za negovata zastapenost vo sekojdnevieto na 
~ovekot. 

 
Upotreba na MS Word 2000 

Tekstualniot ureduva~ MS Word 2000 se koristi za obrabotka na 
tekst kako za doma{na upotreba taka i za upotreba vo firmite i 
administracijata. MS Word 2000  mo`e da se koristi za pi{uvawe na 
pisma, izve{tai, molbi, `albi, tu`bi, diplomi i drugi vidovi na 
dokumenti. Isto taka mo`e da se koristi i za ureduvawe na celi knigi, 
ureduvawe na vesnici, bro{uri  i drugo. So eden zbor mo`e da se 
upotrebuva za obrabotka na  sekakov vid tekstovi. 
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Rabota so MS Word 2000 

Startuvawe na MS Word 2000 

Kako i sekoja aplikacija koja raboti na Windows platforma, 
Microsoft Word 2000 mo`e da se startuva na tri na~ina: od start menito, 
so dvoen klik vrz ikonata na Desktop (ako ja ima), ili so desen klik vrz 
ikonata na Desktop (ako ja ima) pa potoa da se izbere opcijata Open. Po 

startuvaweto se otvara standarden Windows prozorec. 
 

Opis na rabotniot prozor na MS Word 2000 

Rabotniot prozor na  MS Word 2000 kako {to mo`eme da 
zabele`ime od slika 1 e standarden Windows prozor. I se sostoi od 
slednite elementi: 

1. Standardna Windows lenta za naslov so kop~iwata za 
minimizacija, restorirawe i za zatvarawe. 

2. Menito za izbor i zadavawe na komandi. 

3. Lentite so alatki za pobrzo zadavawe na komandite. 

4. Horizontalniot i vertikalniot linear za mestewe na 
tabulatorite. 

5. Rabotnata povr{inata vo koja se prika`uva sodr`inata na 
aktivniot dokument, pretstaven so list hartija. 

6. Od desnata i dolnata strana na dokumentot se nao|aat 
lizga~i za dvi`ewe horizontalno i vertikalno niz 
dokumentot. 

7. Statusnata lenta, koja dava informacii za aktivniot 
dokument ili za zadadenata komanda. 

 

Lenti so alatki 

Lentite so alatki slu`at za pobrzo i poednostavno rabotewe 
so tekstualniot ureduva~. So nivna pomo{ se ovozmo`uva pobrz pristap 
do naj~esto koristenite komandi. Lentite so alatki kako i nivnata 
sodr`ina mo`e da bidat prika`ani ili ne vo zavisnost od `elbata na 
korisnikot. Ako se klikne so desniot taster od gluv~eto vrz nekoja od 
alatkite }e se poka`e lista na alatki. Na listata alatkite koi se 
prika`ani na ekranot se ozna~eni so znakot  pred nivnoto ime, dodeka 
na preostanatite nema. So ednokratno kliknuvawe vrz nekoj od imiwata 
na alatkite taa }e se aktivira (odnosno ako e aktivirana deaktivira). 
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Istoto mo`e da se napravi i preku menito View, so komandata Toolbars, 
koja }e ni ja dade istata lista so alatki. Naj~esto koristeni lenti so 
alatki se  Standard i Formating, a ~estopati se koristat i Borders i 
Drawing. Lentite so alatki mo`eme da gi dvi`ime i pozicionirame na 
bilo koj del od rabotniot prozor. Toa se pravi ako pritisneme na 
desniot taster od gluv~eto vrz alatkata i nepu{taj}i go tasterot ja 
vle~eme alatkata onamu kade {to ni odgovara. 

 
Linear 

Vo MS Word 2000 se koristat horinzotalen i vertikalen 
linear, koi se prika`ani na gorniot i leviot del od dokumentot. So 
linearite se prika`uva  goleminata na stranicata vo santimetri (ili 
vo druga merka za dol`ina vo zavisnost od izborot na korisnikot). 
Horizontalniot linear naj~esto se koristi za  postavuvawe i bri{ewe 
na tabulatori i grani~nici, za postavuvawe na nov red na paragraf i 
dr. Isto taka so linearot mo`e da se menuvaat marginite na stranicata. 
Linearite mo`e da se prika`at ili sokrijat so komandata Ruller od 
menito View. 

 
Statusna lenta 

Statusnata  lenta stoi na dnoto od  prozorecot i dava 
informacii za aktivniot dokument ili za akciite koi se izveduvaat vo 
toj moment. Taa sodr`i informacii za tekovnata stranica, vkupniot 
broj na stranici, aktivnata stranica, brojot na linijata i kolonata vo 
koja se nao|a poka`uva~ot,  poka`uva~ot na modot na rabota i dr. 

 
Dvi`ewe niz dokumentot 

Na koe mesto }e bide napi{an tekstot odreduva poka`uva~ot 
koj trepka. [to zna~i ako sakame da pi{uvame na nekoe mesto prvo 
treba da go doneseme poka`uva~ot na toa mesto. Toa se pravi so 
ednostavno kliknuvawe so desniot taster od gluv~eto na pozicijata na 
koja sakame da pi{uvame. Ako sakame da se dvi`ime i niz delovite na 
dokumentot koj ne se gledaat treba da gi koristime lentite za dvi`ewe. 

Poka`uva~ot osven so gluv~eto mo`e da se dvi`i i 
tastaturata vo tabelata 1 se prika`ani komandite za dvi`ewe niz 
dokumentot.  
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Taster od 
tastaturata 

Komanda 

→ Eden karakter desno 
← Eden karakter levo 
↑ Edna linija nagore 
↓ Edna linija nadolu 

Ctrl + → Eden zbor desno  
Ctrl + ← Eden zbor levo 

End Na krajot od linijata 
Home Na po~etokot od linijata 

Ctrl + ↑ Na po~etok na tekovniot paragraf
Ctrl + ↑ dva pati Na po~etok na prethodniot 

paragraf 
Ctrl + ↓ Na po~etok na sledniot paragraf 
Page up Eden ekran nagore 

Page down Eden ekran nadolu 
Ctrl + Page up Na po~etokot na ekranot 

Ctrl + Page down Na krajot na ekranot 
Alt + Ctrl + Page down Na po~etokot na prethodnata 

stranica 
Ctrl + End Na krajot od dokumentot 

Ctrl + Home Na po~etokot od dokumentot 

 
Tabela 1. 

 
Postavuvawe na parametrite na MS Word 2000 

Po instalacijata na MS Word 2000 potrebno e da se podesat 
parametrite. Parametrite vo MS Word 2000 se podesuvaat so komandata 
Options od menito Tools po {to se dobiva dijalog prozor so koj se 
podesuvaat pove}e parametri od koi pova`ni se: 

• General - Se podesuvaat op{tite parametri, kako {to se 
edini~nana merka (santimetri, in~i ili sl.) 

• View - Pojavuvawe na nekoi elementi na Word - prozorecot, 
kako {to se statusnata lenta, lentite za horizontalno i 
vertikalno dvi`ewe niz dokumentot, vertikalniot linear i 
dr. 
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• Save - Se postavuvaat  parametri za: pravewe rezervni 
kopii na dokumentot (bekap), avtomatsko za~uvuvawe na 
odredeno vreme i sl. 

• Print - Parametri za pe~atewe: pe~atewe na dokumenti vo 
zadnina, vklu~uvawe na crte`i i sl. 

 
Postavuvawe dimenzi na stranica 

Vo praktikata ~estopati pri obrabotka na tekst potrebno e da se 
koristat razli~ni formati na hartijata na koja }e se otpe~ati 
dokumentot t.e. razli~ni od A4. Za taa cel vo tekstualniot ureduva~ MS 
Word 2000 e vgradena specijalna komanda. Toa e komandata Page Setup od 
podmenito File. Po povikuvawe na ovaa komanda se javuva dijalog 
prozorec koj ni gi dava slednive mo`nosti: 

a) Podesuvawe na marginite na stranicata na dokumentot 
(Margins) 

• Gorna (Top), 
• Dolna (Bottom), 
• Leva (Left), 
• Desna (Right), 
• Rastojanie od levata granica na pe~ata~ot (Gutter), 
• Goren Natpis (Headr), 
• Dolen Natpis (Footer). 

 
Ako tekstot se pi{uva za kniga se selektira i opcijata Mirror 

Margins i se postavuva vnatre{na (Inside) i nadvore{na (Outside) granica. 
So komandata Ok izbranite opcii se zadavaat na dokumentot na 

koj se raboti. 
 
b) Izbor na formatot na hartijata (Paper Size) 

• Formatot na hartijata: A4, A5, B5 i dr. 
• Polo`ba na stranicata - vertikalno (Portrait), 
• Polo`ba na stranicata - horizontalno (Landscape) 

 
I ovde isto taka so komandata Ok izbranite opcii se zadavaat 

na dokumentot na koj se raboti. 
 
c) Na~inot na vnesuvawe na listovite vo pe~ata~ot 

• Perforirani listovi (Tractor), 
• Ra~no postavuvawe na listovite (Manual Feed), 
• Magacin so listovi (Sheet Feeder) itn. 
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d) Podesuvawe na razli~ni hederi i futeri za parni i neparni 
stranici, ili samo za prvata stranica i dr. (Layout). 

 
Osnovni operacii vo MS Word 2000 

 
Otvarawe nov dokument 

Nov dokument se otvara so kliknuvawe vrz komandata New od 
podmenito File ili direktno preku tastaturata so komandata Ctrl+N. Po 
{to vedna{ mo`eme da zapo~neme so pi{uvawe na tekst. 

 
Za~uvuvawe na dokument 

Otkako }e zavr{ime so obrabotka na tekst potrebno e da go 
za~uvame gotoviot dokument na diskot ili disketa za ponatamo{na 
upotreba. Toa se pravi so naredbata Save od  File - menito. Po 
zadavaweto na naredbata Save se javuva dijalog prozorec preku koj go 
birame mestoto, vidot (za MS Word  ekstenzijata e doc) i imeto na 
dokumentot pod koe }e go za~uvame, po {to so ednostavno kliknuvawe na 
kop~eto Save dokumentot se za~uvuva. 

 
Otvarawe postoe~ki dokument 

Ako treba da se prodol`i so rabota so nekoj ve}e za~uvan 
dokument se izdava komandata Open od menito File. Po {to se otvara 
dijalog prozorec preku koj go pronao|ame baraniot dokument i so 
pritiskawe na kop~eto Open go dobivame dokumentot, po {to mo`e da 
prodol`ime so obrabotka na istiot. 

 

Zatvorawe na dokument 

Otkako }e zavr{ime so rabota so nekoj dokument istiot  go 
zatvarame so komandata Close od menito File. Ako predhodno toj dokument 
ne sme go za~uvale, MS Word 2000 preku dijalog prozorec ni nudi da go 
za~uvame dokumentot. 

 
Formatirawe na tekst 

Edna od mo`nostite koi ni gi nudi MS Word 2000 e izborot na 
razli~ni vidovi i stilovi na azbuki, kako {to se angliska, makedonska, 
germanska, kineska, arapska, i dr. Izborot na fontot na bukvi se vr{i 
so lentata so alatki Formatting. Od lentata so alatki mo`eme da go 
izbereme fontot(Times New Roman Tahoma, MAC C Swiss, MAC C Times i 
dr.) goleminata na bukvite (11,12,14 itn.), stilot (Bold, Italic, Underline), 
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formatot na tekstot, poramnuvaweto na tekstot (od levo - Left, od desno 
- Right, dvostrano - Justify i centrirano - Center) i dr. 

 
Pe~atewe dokumenti 

Pe~ateweto pretstavuva posledna faza od obrabotkata na 
eden tekst. Pred da se otpe~ati toj tekst prethodno treba da go 
uredime, da vidime kako }e izgleda otpe~aten i da go podesime 
pe~ata~ot. Toa go pravime so komandata Print Preview od menito File. 
Otkako }e zavr{ime so ureduvaweto go zatvarame prozorecot Print 
Preview so kop~eto Close i ja zadavame komandata Print od File - menito 
ili Ctrl+P od tastaturata. Po {to se javuva dijalog prozorec koj ni gi 
dava slednive mo`nosti: 

• Izbor na pe~ata~ (ako ima pove}e pe~ata~i) 
• Broj na stranici (site - All, tekovnata stranica - Current page ili 

navedeni stranici - Pages:1,2,5 itn.) 
• Broj na kopii i dr. 
 
Izleguvawe od MS Word 2000 

Po zavr{uvawe so rabota vo MS Word 2000 potrebno e da go 
izgasime rabotniot prozorec. Toa go pravime so komandata Exit od File - 
menito ili kako i sekoj standarden Windows prozorec so pritiskawe na 
kop~eto x vo desniot goren agol ili so komadata Ctrl+F4 od tastaturata. 

 
Drugi operacii vo MS Word 2000 

 
Poni{tuvawe ili povtorno izvr{uvawe na poslednata 

zvr{ena operacija 

^estopati pri rabotata so tekstovi se slu~uva da izbri{eme 
nekoj zbor, re~enica pa duri i pogolem del od tekstot, no podocna da se 
predomislime i da sakame istiot da go vratime. Toa se pravi so 
komandata Undo Clear od menito Edit, vsu{nost so taa komanda se 
poni{tuvaat pove}e posledni izvr{eni komandi vo sprotiven pravec. 

Sprotivno dejstvo od komadata za Undo e komandata Redo od 
istoto meni. So nea se izvr{uva poslednata izvr{ena operacija. 

 
Ozna~uvawe  na del od dokumentot 

Pri obrabotkata na tekst naj~esto koristeni akcii se 
bri{ewe kopirawe i prenesuvawe na nekoj del od tekstot na drug del. 
No za da se izvr{i nekoja takva operacija potrebno e prethodno tekstot 
so koj }e manipulirame da go ozna~ime. 

 - 17 -



Fondacija Evropa centar za razvoj - Ko~ani  

Ozna~uvawe na nekoj del od tekstot se vr{i ili so gluv~eto 
ili so tastaturata. 

So gluv~eto se ozna~uva taka {to prvin }e go doneseme 
poka`uva~ot na mestoto od kade {to sakame da po~neme, }e pritisneme 
na leviot taster i dr`ej}i go tasterot pritisnat }e go vle~eme gluv~eto 
levo, desno, gore ili dolu se dodeka ne go doneseme poka`uva~ot na 
mestoto do kade {to sakame da go ozna~ime tekstot, potoa go pu{tame 
tasterot po {to ozna~eniot del ostanuva zacrnet. 

So tastaturata se ozna~uva taka da otkako }e go 
pozicionirame kursurot na  mestoto od koe }e po~neme so ozna~uvawe, 
go pritiskame tasterot Shift i dr`ej}i go tasterot so strelkite se 
dvi`ime gore, dolu, levo ili desno kon sakanata pozicija. 

Delovi od tekstot ozna~uvame na slednive na~ini: 
• Zbor - dvapati kliknuvame so gluv~eto vrz zborot 
• Red - gluv~eto go pomestuvame na levata strana od 

redot, polevo od levata granica na dokumentot 
(strelkata dobiva nasoka gore-desno) i kliknuvame 
edna{ 

• Paragraf - isto kako za eden red no kliknuvame 
dvapati 

• Cel Dokument - isto kako i za red ili paragraf no 
prethodno go pritiskame i dr`eme pritisnat tasterot 
Ctrl, ili pak so komandata Ctrl+A. 

Bri{ewe na del od dokument 

Pri obrabotkata na tekst najkoristena akcija e bri{eweto na 
tekst. Vo MS Word 2000  se upotrebuvaat slednive akcii za bri{ewe: 

• Eden znak - ako poka`uva~ot e pozadi znakot se 
pritiska Backspace, a ako  poka`uva~ot e pred nego 
pritiskame Delete. 

• Zbor - na isti na~in kako i eden znak samo {to 
predhodno se pritiska i dr`i Ctrl 

• Del od tekst - prvo go ozna~uvame tekstot a potoa se 
pritiska ili Delete ili Backspace  

 
Otsekuvawe, kopirawe i prenesuvawe na tekst 

Za da otse~eme nekoj tekst istiot prvo treba da se odbele`i. 
Otkako tekstot e odbele`an ja izbirame komandata Cut od Edit - menito 
ili pak zadavame komandata Ctrl+X po {to tekstot go snemuva, {to ne 
zna~i deka tekstot e izbri{an tuku toj e smesten vo poseben del od 
memorijata (Clipboard). 

Ako sakame da kopirame nekoj tekst prvo go selektirame 
istiot i ja izbirame komandata Copy od Edit - menito (ili Ctrl+C so 
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tastaturata) pa potoa go pozicionirame gluv~eto na mestoto na koe 
sakame da go kopirame istiot i ja zadavame komandata Paste  od menito 
Edit (ili Ctrl+V od tastaturata). 

Ako pak treba nekoj tekst da se prenese prvin go otsekuvame 
potoa ja birame pozicijata na koja }e go ostavime pa ja izbirame 
komandata Paste od Edit - menito (ili Ctrl+V so tastaturata). Istot se 
postignuva i ako tekstot go ozna~ime,  pritisneme i dr`eme vrz nego so 
leviot taster od gluv~eto i go vle~eme na sakanata pozicija. 

 
Barawe i zamena na tekst 

^estopati ima potreba da se najde nekoj zbor ili del od 
tekst, za taa cel ja koristime komandata Find od Edit - menito (Ctrl+F). 

Ako pak sakame da najdeme i zamenime nekoj tekst, ja 
povikuvame komandta Replace od Edit - menito (Ctrl+H). 

So ovie komandi osven odredeni zborovi mo`e da se baraat i 
odreden font, pargraf ili format na tekst. 

 

Postavuvawe na prored 

Prored ili rastojanie me|u liniite vo koj se pi{uva tekstot 
se zadava so komandata Praragraph od menito Edit otkako prvo }e go 
ozna~ime tekstot na koj sakame da go podesime proredot. 

Proredot mo`e da bide edini~en (Single), eden i pol  (1.5 
Lines), dvoen (Double), najmal najpogoden (At Least), odreden (Exactly) i 
pove}ekraten (Multiple). 

Prored mo`eme da postavime i direktno  od tastaturata i 
toa: edini~en Ctrl+1, dvoen Ctrl+2 i eden ipol Ctrl+5. 

 
Prenesuvawe na zborovite na slogovi 

MS Word 2000 ima mo`nost da gi prenesuva podeleni na 
slogovi zborovite koi ne gi sobira vo eden red. Za taa cel se koristi 
komandata Hyphenation od menito Tools. 

Prenesuvaweto mo`e da se vr{i ra~no (Manual) ili 
avtomatski (Automatically Hyphanate Document) na celiot dokument 
naedna{. No na makedonski tekst prenesuvaweto se vr{i ra~no. 

Po kliknuvawe na kop~eto Manual od dijalog prozorecot se 
otvara nov dijalog prozorec vo koj e prika`an zborot koj treba da se 
podeli na slogovi, samiot ureduva~ ni predlaga delewe na zborot i po 
doveduvawe na poka`uva~ot na mestoto na koe sakame zborot da bide 
podelen pritiskame na kop~eto Yes a ako ne sakame zborot da bide 
podelen pritiskame No. 
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Formatirawe na tekst vo koloni 

Ako ima potreba tekstot mo`e da se formatira i vo nekolku 
koloni. Toa se postignuva so komandata Columns od menito Format, po 
{to se pojavuva dijalog prozorec preku koj mo`eme da gi podesime 
slednive opcii: 

• Broj na koloni (Number of Columns) 
• [iro~ina na kolonite i rastojanie me|u niv (Width, 

Spacing) 
• Ednakvi koloni (Equal Column Width) 
• Linija me|u kolonite (Line Between) 
• Po~etok na nova kolona (Start New Column) 

 
Vo ramkata Preview se prika`uva kako }e izgleda edna 

stranica od dokumentot. 
 

Goren i dolen natpis 

Goren natpis ili heder (Header) e tekst koj avtomatski se 
pojavuva na po~etokot na sekoja stranica, a dolen natpis ili futer 
(Footer) e isto taka kratok tekst koj se javuva avtomatski na krajot od 
sekoja stranica. Hederot i futerot obi~no se kratki eden do dva reda i 
sodr`at nekoja informacija kako {to se: broj na stranica, ime na 
dokumentot, glavata od taa stranica i sl. 

Heder i futer se kreiraat so komandata Header and Footer od 
menito View, po {to se otvara nova alatka i ureduva~ot avtomatski ne 
vnesuva vo hederot na tekovnata stranica. Preminuvawe od heder vo 
futer se vr{i so strelkite nagore ili nadolu. 

 
Vmetnuvawe na elementi vo dokument 

^estopati vo dokumentite potrebno e da se vnesat nekoi 
elementi kako {to se: po~etok na nova stranica, broevi na stranica, 
simboli, sliki, tabeli, fusnoti itn. Za taa cel vo MS Word 2000 ima 
vgradeno specijalni komandi. 

 
Po~etok na nova stranica 

^estopati ima potreba da se premine vo nova stranica pred 
da se popolni tekovnata. Toa se pravi so komandata Break od menito 
Insert. 
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Numerirawe na stranicite 

Za numerirawe na stranicite se koristi komandata Page 
Numbers od menito Insert, po {to se otvara dijalog prozorec so slednive 
opcii: 

• Position - se bira kade da bide brojot na stranicite i 
toa: na dnoto (Bottom of Page - Footer), na vrvot na 
stranicata (Top of Page - Header) ili na sredinata od 
stranicata (Center) 

• Alignment - se bira mestoto na brojot na stranicata vo 
linijata i toa: levo (Left), desno(Right), vo sredina 
(Center), vo vnatre{niot del (Inside) i vo 
nadvore{niot del (Outside) 

• Show Number on First Page - da se prika`uva ili ne 
brojot na prvata stranica. 

 

Postavuvawe na fusnota i endnota 

Fusnota e objasnuvawe na nekoj del od dokumentot (naj~esto 
poim, zbor i sl.), koj se markira so nekakov znak, a objasnuvaweto se 
javuva na krajot od stranicata. Toa se pravi so komandata Footnote od 
menito Insert, pri {to prethodno poka`uva~ot e pozicioniran  na 
mestoto na koe sakame da ja postavime fusnotata. 

Endnotata e isto {to i fusnota samo {to objasnuvaweto se 
stava na krajot od dokumentot. Za taa cel go pozicionirame 
poka`uva~ot na mestoto kade sakame da postavime endnota i ja 
zadavame komandata Footnote od menito Insert po {to  od dijalog 
prozorecot ja birame opcijata Endnote. 

Od dijalog prozorecot mo`e da se podesi numeriraweto na 
fusnotite i endnotite da se bide avtomatski ili so znak koj nie }e go 
odredime. 

 
Postavuvawe na ramka 

Za da se postavi ramka okolu odreden tekst se zadava 
komandata Frame od menito Insert po {to kurserot se pretvara vo znakot 
+ so koj go ozna~uvame po~etokot na ramkata. Potoa go dr`ime 
pritisnato kop~eto od gluv~eto i go vle~eme do sakanata pozicija za 
sprotiven agol na ramkata. 

 
Vmetnuvawe na simboli 

Mnogu ~esto pri obrabotka na tekst ima potreba od 
koristewe na odredeni simboli. Za taa cel vo MS Word 2000 ima 
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komanda so koja se vmetnuvat simboli. Taa komanda e Symbol od menito 
Insert. Po zadavawe na komandata se otvara prozorec od koj go birame 
fontot a potoa i sakaniot simbol, koj po kliknuvaweto na Instert se 
vnesuva na mestoto na poka`uva~ot. 

 
Vmetnuvawe na slika 

Vo Ms Word 2000 mo`e da se vmetne i slika od fajl ili pak 
od Klipart galerija. Toa se pravi so komandata Picture od menito Insert  
po {to birame dali taa treba da bide od fajl (From File) ili od Klipart 
galerijata (Clip Art). Potoa se pojavuva dijalog prozorec vo zavisnost na 
izbranata opcija od kade ja birame slikata, otkako }e ja izbereme 
slikata pritiskame na Insert. Vmetnata slika ponatamu ja obrabotuvame 
so alatkata za sliki (Picture). 

 

Vmetnuvawe na dokument 

Ako imame potreba da vmetneme nekoj dokument toa go 
pravime so komandata File od menito Insert. Po {to se otvara dijalog 
prozorec sli~en na prozorecot za otvarawe na nov dokument. Po 
pritiskawe na kop~eto Ok dokumentot se vmetnuva na pozicijata na koja 
se nao|a poka`uva~ot. 

 
Vmetnuvawe na objekti 

Pokraj dokumenti kreirani vo MS Word mo`eme da 
vmetnuvame i dokumenti kreirani vo drugi Wndows aplikacii kako {to 
se MS Excel, Corel Draw i dr. toa se pravi so komandata Object od menito 
Insert. Po {to se pojavuva dijaliog prozorec od koj jgo birame tipot na 
dokumentot. 

 
Vmetnuvawe na tabeli 

Za da dokumentite bidat po pregledni ~estopati ni se 
potrebni tabeli. Za da se vmetne tabela vo dokumentot se koristi 
komandata Table od podmenito Insert koe se nao|a vo menito Table. Po {to 
se otvara dijalog prozorec vo koj se podesuva kolku koloni,  kolku 
redovi da ima tabelata i koja da bide {irinata na kolonite. Isto taka 
mo`e da se koristi i nekoja od gotovite formi na tabeli. Toa se pravi 
so pritiskawe na kop~eto AutoFormat. 
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Vmetnuvawe matemati~ki formuli 

Pri obrabotka na tekst ~estopati ima potreba da se vmetne i 
nekoja matemati~ka formula. Toa se pravi so ureduva~ot na formuli 
nare~en Equation Editor, koj se aktivira so kliknuvawe na komandata 
Object od menito Insert, potoa izbirame Microsoft Equation, po {to se 
pojavuva alatka so koja se sreduvaat matemati~kite formuli koi se 
vmetnuvaat na mestoto na poka`uva~ot. 
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Lekcija 8, 9 i 10 

Internet 

Internet pretstavuva edna ogromna kompjuterska mre`a sostavena 
od mnogu pomali mre`i i kompjuteri. Toj vsu{nost, e vo svetski ramki, 
pro{irena mre`a koja me|usebno povrzuva edna ogromna kolekcija od 
kompjuterski mre`i koi {to povrzuvaat milioni kompjuteri, bazi na 
podatoci, programi, fajlovi i lu|e.  

Vo najgolemiot del od svoeto postoewe primarnata primena na 
Internet bila prebaruvawe na podatoci za akademski potrebi. Od 
neodamna, komercijalnite organizacii i golemiot broj na individualni 
korisnici go spoznaa optencijalot na internet. 

Dokolku sakame da pristapime do nekoja informacija na internet, 
potreben ni e soodveten program, kako na primer Internet Explorer. Sekoja 
strana na internet ima svoja adresa (URL Uniform Resource Locator) koja 
go ima sledniov format: 

potokol://ime.kompjuter:port/direktorium/../fajl 
Primer za adresi: 

http://www.yahoo.com http://www.google.com 
http://www.kocani.info http://www.firma.com.mk/produkti/dokument.html

 
Za pregled na nekoja stranica potrebno e vo poleto Address da se 

vnese nejzinata URL adresa, posle {to se pretiska enter. 
Osven za nao|awe na najrazli~ni informacii interntot mo`e da go 

koristime i za elektronska po{ta. 
Elektronskata po{ta e najstar Internet servis koj se pojavil kon 

krajot na sedumdesetite godini. Korisnikot se prijavuva na kompjuter 
povrzan na internet, pi{uva poraka do drug korisnik i vo porakata ja 
vpi{uva e-mail adresata na prima~ot koj mo`e da bide na drugiot kraj 
na svetot. Otkako }e ja napi{e i adreseira porakata, korisnikot ja 
ispra}a i taa patuva niz lavirintot od razli~ni kompjuterski sistemi 
sé dodeka ne mu se ispora~a prima~ot. 

Primer za e-mail: 
evropa@yanoo.com; ime@server.com.mk 
Napomena: e-mail adresa  i adresa na nekoj sajt NE SMEAT DA 

SODR@AT PRAZNO MESTO 
 
Kako {to napomenavme za koristewe na internet servisite 

naj~esto se koristi Internet Explorer koj e standarden Windows prozorec, 
so toa {to negovata lenta so alatki se razlikuva spred dimenziite, a 
nivnoto zna~ewe naj~esto e napi{ano na samata alatka. 

Naj~esto koristeni alatki se: 



Fondacija Evropa centar za razvoj - Ko~ani  

Back - Vra}awe na prethodnata stranica koja bila v~itana vo 
Internet Explorer 

Forward - Ako e koristeno kop~eto Back, povtorno se prika`uva 
slednata stranica 

Stop - Go zapira v~ituvaweto 
Refresh - Povtorno vr{i v~ituvawe na tekovnata stranica i 

nejzinite sliki. 
 

Na WEB stranicite koi gi razgleduvame postojat linkovi 
(hyperlink), {to vsu{nost e tekst ili slika koja go povrzuva dokumentot 
so drug dokument. Naj~esto linkot e so razli~na boja od standardniot 
tekst. 

 

Dokolku sakame da pristapime do nekoja strana so informacii na 
koja ne í ja znaeme URL adresata, potrebno e da ja pobarame taa strana 
preku nekoi specjalni servisi za prebaruvawe. Najpoznati prebaruva~i 
se: 
http://www.kartoo.com http://www.google.com 
http://www.lycos.com http://www.altavista.com 
http://www.yahoo.com  

Eve nekolku soveti koi treba da se poznavaat pri vnesuvawe na 
kreteriumite za prebaruvawe: 

• Treba da se bide {to pokonkreten. Na primer, pove}e uspeh pri 
prebaruvaweto }e se postigne ako se zadade Office 2000 otkolku 
samo Office 

• Ne se vklu~uvaat zborovi od tipot to, the, an, who ..... Servisot 
za prebaruvawe }e gi zanemari. 

• Zborot and (i) se podrazbira. Na primer ako se napi{e Office 
2000 servisot za prebaruvawe }e gi bara stranicite na koi se 
nao|a zborot Office i brojot 2000, no ne mora po toj redosled nitu 
pak zaedno 

• Za prebaruvawe na dva ili pove}e zborovi zaedno, istite treba 
da se stavat vo navodnici, kako na primer "Office 2000" 

• Koga daden zbor ne treba da bide vklu~en vo rezultatot na 
prebaruvaweto se koristi NOT 

 

IRC (Internet Relay Chat) e u{te eden  popularen Internet servis. 
Ovoj servis na korisnicite im obezbeduva zaedni~ki prostor za 
razgovor. Razgovorite se odvivaat preku tastaturata - sekoj u~esnik vo 
razgovorot ja vnesuva svojata diskusija preku tastaturata, a taa se 
pojavuva na kompjuterite na korisnicite koi se vklu~eni vo diskusijata. 
Naj popularna IRC programa e mIRC 
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